Norhayati bt Shaban , 0539724 , Section1 , 8/1/2006,8:54 PM

KOS 1111 – Computer in Science

Assignment 1- Questions in Excel

1) What is a spreadsheet program? How does it differ from a word processing program?


Spreadsheet program is a program that allows you to organize data, complete          
calculations, make decision, graph data, develop professional looking reports, publish 
organized data to the Web, and  access real-time data from Web sites.

Spreadsheet differs from word processing by its operation that can perform calculation, 
while word processing cannot execute calculation. Moreover, spreadsheet also differs 
from word processing in term of interface where spreadsheet has rows and columns. 
This allows it to perform calculation. While word processing have plain space that only 
work with text and numbers that cannot perform calculation.

2) What is the difference between a worksheet and a workbook?


The difference is a worksheet is a sheet inside the workbook that contains a single sheet. 
While, a workbook is a compilation of  worksheets that contains multiple worksheets 
that represented by Tabs at the bottom of Excel screen.
3) How do you copy and move cell contents?
i. Double click the cell that contains the data you want to move or copy.
ii. In the cell, select the characters to move or copy.
iii. To move or copy the selection click cut or click copy on the standard toolbar.
iv. In the cell, click where you want to paste the characters or double-click another cell to move or copy the data.
v. Click paste on the standard toolbar.
vi. Lastly, press enter.
4) How do you use the fill handle to copy contents of cells and to create a sequence? What type of sequences can be created using  the fill handle?


Using fill handle to copy contents of cells:

1. Click the cell where the contents want to be copied.
2. Then, move the mouse pointer to the lower right corner of the selected cell. The mouse pointer will change to cross-hair symbol.
3. Hold down the left button of mouse and drag to copy.


 Sequences that can be created are such as dates, months, even or odd number and  
 many more.

5) How do you create custom headers and footers?
1. Click the worksheet of interest.

2. On the View menu, click Header and Footer.

3. To base a custom header or footer on an existing header or footer, click the header or footer in the Header or Footer box. 

4. Click Custom Header or Custom Footer.
5. Click in the Left section, Center section, or Right section box, and then click the buttons to insert the header or footer information you want in that section. 

6. After finish, click Close.

6) What is a relative cell address reference? How do you change a relative reference to an absolute reference? What is a mixed cell address reference?


A relative cell address reference is a cell reference, such as A1, that is used in a 
formula that changes when the formula is copied to another cell or range. After the 
formula is copied and pasted, the relative reference in the new formula is changed 
to refer to a different cell that is the same number of rows and columns away from 
the formula as the original formula.

Changing a relative reference to an absolute reference:

1. Select the cell that contains the formula.

2.  In the formula bar, select the reference you want to change. 

3. Press F4 to toggle through the combinations. The "Changes To" column reflects how a reference type updates if a formula containing the reference is copied two cells down and two cells to the right. For example, if you select the address $A$2 in a formula and press F4, the reference becomes A$2. Press F4 again and the reference becomes $A2 and so on.                             

A mixed cell address reference is a mixed reference that has either an absolute column 
reference or an absolute row reference. The column reference changes when the cell 
reference is copy  to another column because it is relative. While, the row reference 
changes when the cell reference is copy to another row because it is relative. 
7) What is the formula bar? What is the name box?


A formula bar is a bar that located below the Standard and Formatting toolbars that is 
use to enter or edit values or formulas in cells or charts. It shows the constant value or 
formula stored in the active cell. To display or hide formula bar, click Formula Bar on 
the View menu.


A name box is the box located on the left side of the formula bar that shows the active 
cell reference.

8) What is the difference between erasing the contents of a column and deleting the column?


Deleting the column means we discard the specific column from the worksheet. While, 
erasing the contents of a column means we delete the content to make the cell blank, 
consist none text or formula. So the column still exists in the worksheet.
9) How will you freeze a part of the worksheet?
1. Select the rows or columns to be frozen.

2. Then, on the Window menu, click Freeze Panes
10)  What is the maximum number of significant digits possible in MS Excel?


The maximum number of significant digits possible in MS Excel is 99999999999. So, 
the total digits are 11.
11)  What is the difference between a bar chart and a histogram?


Bar chart is aligned horizontally while histogram is aligned vertically. In term of 
function, bar chart is used in comparing the group of data where as we go along the x-
axis it is increasing or decreasing. While, histogram is used as analysis tool to calculate 
individual and cumulative frequencies for a cell range of data and data bins
12)  How will you put the error bars in the x-y plot? Make a table with a data points along with their errors bars shown. (hint: See Help facility in Excel)
1. Click the data series to where the error bars will be added.

2. On the Format menu, click Selected Data Series. 

3. On the X Error Bars tab or the Y Error Bars tab, select the options you want. 

13)  How will you protect a workbook in Ms Excel?
       First, on the Tools menu, point to Protection. Then click Protect Workbook.
14)  How to protect only selected cells in MS Excel? 
1. Select all the cells that contain information that want to be protected.

2. Then, click Tools menu.

3. Choose Protection.

4. Lastly, click Protect Sheet.
15)  Explain the different forms of log functions available in MS Excel.
1. LOG

· Returns the logarithm of number to the base you specify.

· Syntax

· LOG(number,base)
· Number: positive real number for which you want the logarithm.

· Base : is the base of the logarithm. If base is omitted, it is assumed to be 10.
2. IMLOG2

· Returns the base-2 logarithm of a complex number in x + yi or x + yj text format.
· If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.
· Syntax
· IMLOG2(inumber)
· Inumber    is a complex number for which you want the base-2 logarithm
· Remarks
· Use COMPLEX to convert real and imaginary coefficients into a complex number. 

· If number is not in the form x + yi or x + yj. IMLOG2 returns the #NUM! error value.

· The base-2 logarithm of a complex number can be calculated from the natural logarithm.

3. IMLOG10

· Returns the common logarithm (base 10) of a complex number in x + yi or x + yj text format
· If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.
· Syntax :
· IMLOG10(inumber)

· Inumber    is a complex number for which you want the common logarithm.

· Remarks :
· Use COMPLEX to convert real and imaginary coefficients into a complex number. 

· If number is not in the form x +yi or x + yj, IMLOG10 returns the #NUM! error value.

· The common logarithm of a complex number can be calculated from the natural logarithm.

16)  In MS Excel, the argument of the sin functions should be in radians. Assume that you are provided with a set of angles in degrees. Use radians function in MS Excel to express angles in radians and then find out the sin of these functions.
17) Use of help facilities in Excel: Go through the Help facilities in Excel and study several different types of functions. Explain the application of three different uncommon functions using your own examples.

1. BIN2HEX
· Converts a binary number to hexadecimal.
· If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.
· Number is the binary number you want to convert. Number cannot contain more than 10 characters (10 bits). The most significant bit of number is the sign bit. The remaining 9 bits are magnitude bits. Negative numbers are represented using two's-complement notation.
· Places   is the number of characters to use. If places is omitted, BIN2HEX uses the minimum number of characters necessary. Places is useful for padding the return value with leading 0s (zeros).
· Remarks :
· If number is not a valid binary number, or if number contains more than 10 characters (10 bits), BIN2HEX returns the #NUM! error value.

· If number is negative, BIN2HEX ignores places and returns a 10-character hexadecimal number. 

· If BIN2HEX requires more than places characters, it returns the #NUM! error value. 

· If places is not an integer, it is truncated.

· If places is nonnumeric, BIN2HEX returns the #VALUE! error value. 

· If places is negative, BIN2HEX returns the #NUM! error value. 

· Example : =BIN2HEX (11111011,4) . This formula converts binary 11111011 to hexadecimal with 4 characters (00FB)

2. CONVERT

· Converts a number from one measurement system to another. For example, CONVERT can translate a table of distances in miles to a table of distances in kilometers.
· If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.
· CONVERT(number,from_unit,to_unit)
· Number   is the value in from_units to convert
· From_unit   is the units for number.
· To_unit   is the units for the result. CONVERT accepts the following text values (in quotation marks) for from_unit and to_unit
· Remarks :
· If the input data types are incorrect, CONVERT returns the #VALUE! error value. 

· If the unit does not exist, CONVERT returns the #N/A error value.

·  If the unit does not support an abbreviated unit prefix, CONVERT returns the #N/A error value. 

· If the units are in different groups, CONVERT returns the #N/A error value. 

· Unit names and prefixes are case-sensitive

· Example : =CONVERT (1.0, “lbm”,”kg”). This formula converts 1 pound mass to kilograms (0.453592)

3. DELTA

· Tests whether two values are equal. Returns 1 if number1 = number2; returns 0 otherwise. Use this function to filter a set of values. For example, by summing several DELTA functions you calculate the count of equal pairs. This function is also known as the Kronecker Delta function.

· If this function is not available, and returns the #NAME? error, install and load the Analysis ToolPak add-in.

· DELTA(number1,number2). Number1   is the first number. Number2   is the second number. If omitted, number2 is assumed to be zero.

· Remarks : 

· If number1 is nonnumeric, DELTA returns the #VALUE! error value.

· If number2 is nonnumeric, DELTA returns the #VALUE! error value. 

· Example : =DELTA(5, 4). This formula checks whether 5 and 4 are equal or not. The result will show (0) because 5 and 4 are not equal. The result will show (1) if the two values are equal. 

18) Calculation using Formulas: Select any formula (as complicated as possible) from any one of your textbooks. Use Excel to calculate this formula, by entering the constants and the variables separately.  (For example:
i. Gas constant = … units

ii. Temperature = …. units

iii. Pressure        =  ..  units

iv. Voulme        =   formula)

19) Multiplot: Write down any one formula with two constants (a and b) and one variable (x). (eg. y=a sin(bx) or y=a x + b log (x) …etc).  You can also make up your own formula.  Use Excel to calculate your chosen formula for a range of x values at five different sets of constant values and tabulate them as x vs y with x in the first column and y in the next four columns as follows:

	No.
	x
	y values calculated using different set of constants

	
	
	a= …. b=…
	a= …. b=…
	a= …. b=…
	a= …. b=…

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


Plot all the four curves in the same plot and label them differently.  Comment on the effect of the constants on these plots.

20) Solving Simultaneous Equations: Write a set of five equations with five variables (eq. p, q, r, s, t and u) and solve them using Excel.  Verify your answer by back substitution

21) Solver exercise: The following data set is obtained in an experiment:

	R
	V

	0.5
	127.0355

	1.0
	48.0715

	1.5
	12.1348

	2.0
	8.3139

	2.1
	5.3366

	2.2
	3.1064

	2.3
	1.5361

	2.4
	0.5472

	2.5
	0.0689

	2.6
	0.0374

	2.7
	0.3957

	2.8
	1.0921

	2.9
	2.0807

	3.0
	3.3199

	3.1
	4.7728

	3.2
	10.0998

	3.5
	20.7786

	4.0
	31.9924

	4.5
	42.6319

	5.0
	52.1824

	5.5
	60.4667

	6.0
	67.4911


Use the solver module in Excel to fit the data using the equation 

V=a(1-exp(-b(R-c)))2,

where a, b and c are constants to be determined.  Use solver to determine these constants.  Calculate the V values using the values of a, b and c that you had found out by excel.  Plot the experimental and the calculated data in the same plot and label them properly.  What is the value of V at R=1.25 and R=c?

22) Solve Van der Waals's equation: (P + a/V2)(V - b)=RT, for the volume per mole (V) of an organic compound at 10 atm pressure and 400oK. The Van der Waals's constants for this particular compound are a = 40.0 liter2 atm/mole2 and b = 0.2 liter/mole. (Hint: use Goal Seek)
23) Select any equation such as given in the above question, from any of your text books and solve it using goal seek.

24) Grades distribution: Consider a class consisting of 12 to 20 students.  Create their mark list in their final exam.   The list should contain their names and their marks in two columns. Use the nested “if condition” to determine their grades (eg. A, B ….) and list them in the third column.  Present their grade distribution as a histogram and as a pie chart.
25) Computerization of the laboratory report:  Present any of your experimental laboratory report involving detailed calculations and graphs, as an Excel workbook.  Your report should be self-contained and contain all the details to verify your graphs and results.  In short it should look as lab report that you would submit after completing your experiment.

           DETERMINING THE ACCELERATION.

           OBJECTIVE :To investigate the changes in the motion of a dynamics chart that occurs when different net force is applied                            .                                                           THEORY:

 Isaac Newton described the relationship of the net force applied to an object and the acceleration in the following way: the acceleration (a) of an object is directly proportional to and in the same directions the net force, Fnet and inversely proportional to the mass (m) of the object.

APPARATUS:

Mass set and mass hanger

Balance (for measuring mass)

PROCEDURE:

1. Measure all the mass set by using the balance.

2. Calculate the value of Fnet by using the formula F = mg.

3. Use the value of Fnet and mass to perform a graph of Fnet vs. mass.
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